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1. Why discrepancies between RUSLE 2 and 
SnapPlus?  

2. How manure applications are handled in SnapPlus    

3. Review of identical managements modeled in 
RUSLE2 and SnapPlus         

4. Use of Supporting Practices 

5. Use STIR values to match field tillages to those in 
SnapPlus   



Why discrepancies between RUSLE 2 and SnapPlus? 

RUSLE2 is 
embedded in 

SnapPlus 

SnapPlus annual 
releases include 

updates to RUSLE2 
soils and 

management 
databases  



Why discrepancies between RUSLE 2 and SnapPlus? 

SnapPlus uses RUSLE2 to calculate 
rotational soil loss for the designated 

Dominant Critical Soil  

Differences in calculated soil loss for the same soil map unit, 
slope and slope length can arise because RUSLE2 users can 
enter different : 
o Tillage and other soil disturbing activities 
o Residue removal operations 
o Operation dates 
o Cover cropping planting and termination dates 
o Manure consistency and methods of application 
o Vegetation types and yields 
o Practices 
 
      
 



Why discrepancies between RUSLE 2 and SnapPlus? 
Each SnapPlus crop and tillage selection is linked to 
a RUSLE2 management template 

CMZ 01\a.Single Year/Single 
Crop Templates\Corn grain\ 
corn grain;FC, twist, fcult,  z1  

CMZ 04\a.Single Year/Single 
Crop Templates\Corn grain\ 
corn grain;FC, twist, fcult,  z4 

or 



Why discrepancies between RUSLE 2 and SnapPlus? 

   
Grain crop yields in SnapPlus  

Yield used in SnapPlus 
RUSLE2 soil loss calculation 
is mid-point of range 

Yield ranges in 
SnapPlus lists are 
from UW-
Extension  
Fertilizer guidance 
(A2809) 



Tillage choices 
limited in 

SnapPlus for 
usability: 
Maximum 

number per 
crop is 11 

Why discrepancies between RUSLE 2 and SnapPlus? 

In RUSLE2 operations files are 
30 Core soil disturbing tools that 
can be used in numerous 
combinations 



Why discrepancies between RUSLE 2 and SnapPlus? 

Cover crops 
SnapPlus 
Crop: Corn silage to small grain cover 
Tillage: Spring Chisel, no disk, cover crop disked              

RUSLE2 



Why discrepancies between RUSLE 2 and SnapPlus? 

Double crops 
SnapPlus  
Crop: Peas to Snapbean to small grain cover 
Tillage:  Chisel Plow, cover crop disked 

RUSLE2 Double crops often are not 
ideal representations of what is  
happening in the field because 
most assume same tillage for 
first and second crop.  



 
 Manure  

 

When manure is applied to fields regularly on a consistent basis, 
the planner should include manure in the RUSLE2 management 
file.   

 If manure is not applied regularly or consistently you can ignore 
the application, when surface applied and not incorporated 

 

SnapPlus  

Includes all incorporated and surface-applied manures and biosolid 
dry matter applications in its RUSLE2 calculations 

RUSLE2 



 
 Manure  

 
 R2 and SnapPlus/R2 use  % solids to assign manure residue type. 

 Liquid, slurry, semi-solid and poultry  manure types are entered at 
a dry matter rate that is 50% of solids application. 

  Solid manures (>20% dry matter) are  entered at 100% of solids 
application rate.  

 SnapPlus uses A2809 guidelines for default dry matter contents 
by manure type/consistency.   



15% dry matter in 15 tons/a = 4500 lb/acre 
4500 x 0.5 = 2250 lb/acre 

 
 Manure  

 



 
Manure  

 
SnapPlus Manure Application Dates for RUSLE2 
Soil Loss Calculations: 

 Fall: November 1 (CMZ4) or October 15 (CMZ1) 
or before date of first fall operation 

Winter: January 15 
Spring: April 25 or before date of first spring 

operation 
Summer: July 21 



Rotational Soil Loss in SnapPlus2.0 and RUSLE2 1.26.6.4 



Rotational Soil Loss in SnapPlus2.0 and RUSLE2 1.26.6.4 



Rotational Soil Loss in SnapPlus2.0 and RUSLE2 1.26.6.4 

RUSLE2 version 1.26.6.4 SnapPLus V2.

Soil Loss: 5.3 T/a/yr Soil Loss: 5.4 T/a/yr

SCI: 0.2 SCI: 0.2

Date, m/d/y Operation Vegetation

Yield  

(# harv. 

units) R2 OPERATIONS:

11/1/2001 Chisel, twisted shovel 11/1/1: operations\Chisel, twisted shovel 

4/28/2002 Cultivator, field 6-12 in sweeps 4/28/2: operations\Cultivator, field 6-12 in sweeps

5/1/2002 planter, double disk opnr Corn, grain 160.5

5/1/2: operations\planter, double disk opnr  Yield 

goal: 160.5

10/20/2002

Harvest, killing crop 50pct standing 

stubble

10/20/2: operations\Harvest, killing crop 50pct 

standing stubble

5/15/2003

Planter, double disk opnr, 18 in 

rows

Soybean, 

mw 15 - 20 

in rows 50.5

5/15/3: operations\Planter, double disk opnr, 18 in 

rows Yield goal: 50.5

10/10/2003

Harvest, killing crop 50pct standing 

stubble

10/10/3: operations\Harvest, killing crop 50pct 

standing stubble

Standardized operations, vegetation, yields.  
SnapPlus 0.1 T/a/yr higher. 
Difference results from use of RUSLE2 ver. 2.4.1.0 in SnapPlus 



3.6 t/acre/yr 

6-yr rotation 

Rotational Soil Loss in SnapPlus2.0 and RUSLE2 1.26.6.4 



Rotational Soil Loss in SnapPlus2.0 and RUSLE2 1.26.6.4 

Soil loss: 3.6 in RUSLE2 
                3.8 in SnapPlus 
 

Rotational Soil Loss in SnapPlus2.0 and RUSLE2 1.26.6.4 



Rotational Soil Loss in SnapPlus2.0 and RUSLE2 1.26.6.4 
Soil Loss: 3.6 T/a/yr Soil Loss: 3.8 T/a/yr

SCI: 0.2 SCI: 0.2

Date, 

m/d/y Operation Vegetation

Yield (# 

harv. 

units)

Type of cover 

material

Cover 

matl 

add/rem

R2 

OPERATI

ONS:

10/15/2001 Manure spreader, solid and semi-solid Manure, solid, signif. bedding2000 10/15/1: operations\Manure spreader, slurry: residues\Manure, solid, signif. bedding- added:2000

10/16/2001 Chisel, st. pt. 10/16/1: operations\Chisel, twisted shovel 

5/5/2002 disk, tandem light finishing 5/5/2: operations\disk, tandem light finishing 

5/10/2002 Cultivator, field 6-12 in sweeps 5/10/2: operations\Cultivator, field 6-12 in sweeps

5/10/2002 planter, double disk opnr Corn, grain 120.5 5/11/2: operations\planter, double disk opnr  Yield goal: 120.5

10/15/2002 Harvest, killing crop 50pct standing stubble 10/10/2: operations\Harvest, killing crop 50pct standing stubble

10/15/2002 Manure spreader, solid and semi-solid Manure, semi-solid 1000 10/15/2: operations\Manure spreader, slurry: residues\Manure, slurry- added:1005

10/16/2002 Chisel, st. pt. 10/16/2: operations\Chisel, twisted shovel 

5/5/2003 disk, tandem light finishing 5/5/3: operations\disk, tandem light finishing 

5/10/3: operations\Cultivator, field 6-12 in sweeps

5/10/2003 planter, double disk opnr Corn, grain 120.5 5/11/3: operations\planter, double disk opnr  Yield goal: 120.5

10/15/2003 Harvest, killing crop 50pct standing stubble 10/10/3: operations\Harvest, killing crop 50pct standing stubble

10/16/2003 Manure spreader, slurry Manure, slurry 2500 10/15/3: operations\Manure spreader, slurry: residues\Manure, slurry- added:2490

10/17/2003 Chisel, st. pt. 10/16/3: operations\Chisel, twisted shovel 

5/5/2004 disk, tandem light finishing 5/5/4: operations\disk, tandem light finishing 

5/13/2004 Cultivator, field 6-12 in sweeps 5/10/4: operations\Cultivator, field 6-12 in sweeps

5/15/2004 planter, double disk opnr Corn, silage 23 5/15/4: operations\planter, double disk opnr  Yield goal: 23

9/10/2004 Harvest, silage 9/10/4: operations\Harvest, silage 

10/20/2004 Chisel, st. pt. 11/1/4: operations\Chisel, twisted shovel 

4/13/2005 disk, tandem light finishing 4/15/5: operations\disk, tandem light finishing 

4/20/2005 Cultivator, field 6-12 in sweeps 4/20/5: operations\Cultivator, field 6-12 in sweeps

4/21/2005 Drill or airseeder, double diskAlfalfa, spring seed 1.5 4/21/5: operations\Drill or airseeder, double disk   Yield goal: 1.5

7/15/2005 Harvest, hay, legume Alfalfa, spring seed regrowth after cutting 1.5 7/15/5: operations\Harvest, hay, legume  Yield goal: 1.5

9/1/2005 Harvest, hay, legume Alfalfa, spring seed senes to y2 regrowth1.5 9/1/5: operations\Harvest, hay, legume  Yield goal: 1.6

6/1/2006 Harvest, hay, legume Alfalfa, yr2 regrowth after cutting 1.5 6/1/6: operations\Harvest, hay, legume  Yield goal: 1.5

7/15/2006 Harvest, hay, legume Alfalfa, yr2 regrowth after cutting 1.5 7/15/6: operations\Harvest, hay, legume  Yield goal: 1.5

9/1/2006 Harvest, hay, legume Alfalfa, yr2 senes to yr3 regrowth 2.25 9/1/6: operations\Harvest, hay, legume  Yield goal: 2.5

9/6/2006 Manure spreader, slurry Manure, slurry 1251 10/15/6: operations\Manure spreader, slurry: residues\Manure, slurry- added:1245

6/1/2007 Harvest, hay, legume Alfalfa, yr3 regrowth after cutting 1.7 6/1/7: operations\Harvest, hay, legume  Yield goal: 1.5

7/15/2007 Harvest, hay, legume Alfalfa, yr3 regrowth after cutting 1.7 7/15/7: operations\Harvest, hay, legume  Yield goal: 1.5

9/1/2007 Harvest, hay, legume Alfalfa, yr3 senes to yr4 regrowth 2.5 9/1/7: operations\Harvest, hay, legume  Yield goal: 2.5

Standardize – RUSLE2 soil loss goes up to 3.8 T/a/yr  
Small differences due to SnapPlus RUSLE2 is v.2 

Rotational Soil Loss in SnapPlus2.0 and RUSLE2 1.26.6.4 



Rotational Soil Loss in SnapPlus2.0 and RUSLE2 1.26.6.4 

How to Find the RUSLE2 operations used in SnapPlus 

1) View > Preferences> Set Debug verbosity to 4 

Rotational Soil Loss in SnapPlus2.0 and RUSLE2 1.26.6.4 

Model Exerciser now visible in Tools Menu  



Rotational Soil Loss in SnapPlus2.0 and RUSLE2 1.26.6.4 

How to Find the RUSLE2 operations used in SnapPlus 

Rotational Soil Loss in SnapPlus2.0 and RUSLE2 1.26.6.4 

2) Tools > Model Exerciser > Erosion tab >  Run, then View Dump  



Rotational Soil Loss in SnapPlus2.0 and RUSLE2 1.26.6.4 

 
    I N P U T S 

    =========== 
 
R2 OPERATIONS: 
10/15/1: operations\Manure spreader, slurry: residues\Manure, slurry- added:830 
5/10/2: operations\Chisel, twisted shovel  
5/15/2: operations\Cultivator, field 6-12 in sweeps 
5/16/2: operations\planter, double disk opnr  Yield goal: 23 
9/10/2: operations\Harvest, silage  
9/14/2: operations\Disk, tandem heavy primary op. 
9/15/2: operations\Drill or airseeder, double disk   Yield goal: 3300 
10/15/2: operations\Manure spreader, slurry: residues\Manure, slurry- added:830 
5/10/3: operations\Chisel, twisted shovel  
5/15/3: operations\Cultivator, field 6-12 in sweeps 
5/16/3: operations\planter, double disk opnr  Yield goal: 23 
9/10/3: operations\Harvest, silage  
9/14/3: operations\Disk, tandem heavy primary op. 
9/15/3: operations\Drill or airseeder, double disk   Yield goal: 3300 
 
R2 ATTRIBUTES: 
#RD:MAN_BASE_PTR:MAN_BASE_ROTATION_CHOICE = Yes 
#RD:SLOPE_ROT_BUILD_SUB_OBJ_PTR:NUM_ROTATION_BUILDER_MANS[1] = #INSERT 
#RD:SLOPE_ROT_BUILD_SUB_OBJ_PTR:ROT_BUILD_APPLY = Yes 
#RD:SLOPE_ROT_BUILD_SUB_OBJ_PTR:ROTATION_BUILDER_MAN_PTRS = managements\CMZ 01\a.Single 
Year/Single Crop Templates\Corn silage\corn silage;SC, twist, fcult, with disked rye cover z1#1 
#RD:SLOPE_ROT_BUILD_SUB_OBJ_PTR:ROTATION_BUILDER_MAN_PTRS[1] = managements\CMZ 01\a.Single 
Year/Single Crop Templates\Corn silage\corn silage;SC, twist, fcult, with disked rye cover z1#2 
CLIMATE_PTR = climates\USA\Wisconsin\Bayfield County 
EXT_RES_PTR = residues\Manure, slurry 
OP_DATE = 10/15/1 
OP_PTR = operations\Manure spreader, slurry 

How to Find the RUSLE2 operations used in SnapPlus 

Step 3. RUSLE2 Managements will be listed in Dump 

Rotational Soil Loss in SnapPlus2.0 and RUSLE2 1.26.6.4 

Hint: Deactivate other fields in field screen 
so do not have huge Dump report 



Use of Supporting Practices   

Not in SnapPlus 



Supporting Practices in SnapPlus 

RUSLE2: 
Contouring\Relative 
row grade 10% of 
slope grade 

RUSLE2: 
 Strip cropping\ 
2 Strip rotational 0-2 

RUSLE2:  
Contour Buffer Strips\Actual 
width 15 ft\1-Cool season grass 
buffer midslope 15 feet wide 

RUSLE2:  
Filter Strips\Actual 
width\30-ft Cool 
season grass filter 
strip (with 30 ft 
added to end of slope 
length) 

Use of Supporting Practices   



Relative row grade and absolute row grade contouring 
 Snap-Plus uses 10% relative row grade instead of absolute 

row grade. 
 RUSLE2 guidance suggests the use of relative row grade—

WHY? 
 

10% Relative row grade is more conservative than using 1% absolute row 
grade for contouring on  steep land and less conservative on flatter land. 

  

1% Absolute Row Grade: 

On a 6% slope: Relative row grade is 1/6 = 17% which gives a contouring  sub-
factor value of 0.70  (sub-factor value is 0.50 for perfect contouring).  

On a 30% slope: Relative row grade is 1/30 = 3.3%  with a contouring sub-
factor value of 0.59 
 
 

Use of Supporting Practices   



Assigning a SnapPlus Tillage 

What if the ground 
disturbing operation 
on a field is not in the 
SnapPlus list? 



Assigning a SnapPlus Tillage 

Each operation in 
RUSLE2 has a STIR Value.  
We can compare the 
STIR values for the fall 
and spring operations on 
a field to those in 
SnapPlus to find the 
closest match. 
 

Soil Tillage Intensity Rating 



STIR Values for various operations 

• operations\Cultivator, field 6-12 in sweeps--26 

• operations\Disk, single gang--19.5 

• operations\Disk, tandem light finishing—19.5   

• operations\Rotary hoe—16.6 

• operations\Seedbed conditioner, coulter  caddy, 
coil tine harrow —16.6 

Assigning a SnapPlus Tillage  



Assigning a SnapPlus Tillage 

What if the ground disturbing 
operation on a field is not in the 
SnapPlus list? 

Check the STIR values 


